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 Volume 5, Issue 21      TAKE ONE HOME - NO CHARGE      24 - 5 - 07 









THE WINNING TEAM COLLECT THEIR PRIZE AT THE VERY SUCCESSFUL CHARITY TABLE QUIZ IN THE RATOATH INN.





LOTTO RESULTS 5- 12- 06


NUMBERS DRAWN 2,13,17,20.


NO JACKPOT WINNER                               THE €50 WINNERS WERE 


James Duncan c/o R.H.                        Paul Cambell c/o K. Brennan                          Tony McIntyre c/o K. Brennan               Eileen McMahon c/o T. Reilly


NEXT WEEKS JACKPOT IS €5000 AND THE DRAW WILL TAKE PLACE IN THE AULD STAND


(On duty M. Woods & J. Connor)

















Your By-line


Your Company Name


This document was created using linked text boxes, which allow articles to flow continuously across pages. For example, this article continues on page two, while the one to the right continues on page three. When you add lines of words to a text box, the words in the following text box flows forward. When you delete lines of words from a text box, the words in the next text box moves backward. You can link several text boxes in an article, and you can have multiple articles in a document. The links do not have to occur in a forward direction.


Inserting Linked Text Boxes


To insert linked text boxes in a document, click Text Box on the Insert menu. Click and drag in your document where you want to insert the first text box, and insert additional text boxes where you want the text to flow.


To select the first text box, move the pointer over the border of the text box until the pointer becomes a four-headed arrow and then click the border. Click the right mouse button, click Create Text Box Link and then click in the text box where you want the text to flow. Repeat these steps to create links to additional text boxes.


In the first text box, type text that you want. As the text box fills, the text will flow into the other text boxes that you’ve linked. To let the reader know that an article will continue on another page, insert a small text box under the text box, choose the Jump To style, and then type the words “Continued on Page.” Click Cross-reference on the Insert menu. Choose Heading from the Reference type drop-down list, and Page Number from the Insert Reference To. Select the name of the follow-up heading from the For Which Heading list box and then click Insert.


Formatting Text Boxes


You can change the look of linked text boxes by using color, shading, borders, and other formatting. Select the text box you want to format and then double click its border to open the Format Text Box dialog box. If you want to change the color or borders on a text box, choose the Colors and Lines tab. To change the size, scale, or rotation, click the Size tab. To change the position of the text box on the page, click the Position Tab.  If you have other text surrounding the text box, and want to change the way the text wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.(





RATOATH      GARDEN CENTRE


EVERYTHING 


FOR THE GARDEN


NEW GIFT SHOP ALSO OPEN


RATOATH ROAD ASHBOURNE


PH. 8256678








MANAGER REQUIRED





Ratoath Harps are currently looking for a manager for their reserve team.


The team plays in Div. 1c (Sat.) of the Leinster Senior League.         


For further information contact Brian Conway at 087-6888960





FIXTURES SUN. 27th MAY


L.S.L. Major 1


Ratoath Harps v Bath Rangers 2-30 A


R.H. Ladies v Balbriggan 7-15 A (Mon)


D.D.S.L.


7A1 v ?


8B1 v ?


9B1 v ?


10A1 v ?


N.D.S.L.


11B v ?


12A v ?


12D v ?


13P v Ashbourne 7oC H (Tues)


13C v Raheny 10oC A


13E v ?


14P v ?


14C v ?


14D v ?


15A v Grange Woodbine 10-30 A


16B v ?


18P v ?











RATOATH HARPS


 ALL WEATHER PITCH





AS THE SOCCER SEASON COMES TO A CLOSE SOME TIMES ARE BECOMING AVAILABLE ON OUR ALL –WEATHER PITCH FOR THE SUMMER MONTHS.


 FOR FURTHER INFORMATION CONTACT JIMMY AT O87-2444627














FIXTURES SAT. 26th MAY





L.S.L. Div. 2


Ratoath Harps v Farm Utd. 2-30 A 





This is a vital game for Ratoath and may decide where the league title ends up. All support will be welcomed.





D.D.S.L.


11A1 v Palmerstown 10-30 A


12A v Kilnamanagh 12oC H





N.D.S.L.


8C1 v Kinsealy 10oC H


9B v Skerries 10oC A


9C1 v ?


9D v Ashbourne 10-45 H


9E v ?


10B v St. Columbans 8-15 H (Mon)


10C1 v ?


11A1 v Balscaddan 7-15 H (Mon)











SIOBHAN AND DAVY O NEILL PLAY TO A RELATIVALY SMALL CROWD IN VERONICA BORDELLO DURING CHRISTMAS.





The Harp is an information leaflet produced by Ratoath Harps F.C. with the assistance of                          Philip Wallace & Oltech-Olivetti, National Distributors of copiers, fax, printers and supplies. 





CONGRATULATIONS CONOR


CONOR DEVEREUX HAS BECOME THE FIRST RATOATH HARPS PLAYER TO REPRESENT THE CLUB ON THE INTERNATIONAL STAGE. HE WON HIS FIRST CAP RECENTLY, IN SWITZERLAND, WHEN IRELAND PLAYED BELGIUM IN AN UNDER FIFTEEN INTERNATIONAL. CONOR DID WELL IN THE GAME AND WAS TAKEN DOWN FOR A PENALTY FROM WHICH IRELAND SCORED. HE EARNED HIS SECOND CAP, PLAYING A FULL GAME AGAINST SWITZERLAND, AND HAS ALSO BEEN CALLED UP FOR DUTY IN THE UPCOMING TOURNAMENT IN DUBLIN AGAINST NORTHERN IRELAND AND WALES ON MAY 25TH TO 27TH.  CONGRATULATIONS FROM ALL AT RATOATH HARPS. 


POLIKOFF CUP FINAL


RATOATH HARPS 0…..ST.PATS C.Y. 3


There was disappointment for Ratoath Harps last Saturday evening in Frank Cooke Park when a strong and talented St. Pats side got a deserved victory. Ratoath started well on the excellent pitch and the Pats keeper had to make some early saves as Marcus Cowzer and Jordan Lancaster threatened. As the game progressed St. Pats improved and scored a great goal after twenty five minutes when a twenty metre bullet gave Harps keeper Gary Duff no chance. Ratoath almost conceded a second just before the break but it remained 0-1 at half time. In the first half the teams looked evenly balanced but when Pats scored their second goal, despite the best efforts of The Harps keeper, they raised their game and showed why they won the Major league of the L.S.L. with ease. The Harps conceded a third goal before the final whistle and can have no complaints with the final outcome. Ratoath captain Gareth Wilson put in an excellent ninety minutes as did Danny Lonergan in midfield and centre half Derek O Neill had a towering game in defence. Ratoath have to raise themselves up now as they have unfinished business in the league to attend to. Team; Gary Duff, Derek Kavanagh, Derek O Neill, Gareth Wilson, Joey Burke, Ritchie O Brien, Danny Lonergan, David Geraghty, Graham Kavanagh, Marcus Cowzer, Jordan Lancaster. Subs; Robbie Burke, Robbie Kelly, Matt Conway.


PEAMOUNT 2 RATOATH HARPS 4


Ratoath made a good come back from their Cup defeat with a 4-2 away win over Peamount in the league last Tuesday evening. The Harps took a 2-0 lead but Peamount got one back before the break and levelled in the second half. The score stayed at 2-2 until the last ten minutes of the game when Marcus Cowzer and Jordan Lancaster came to the Harps rescue to keep their title hopes alive. Ratoath visit Manortown on Thursday evening and their final league game is next Sunday away to Bath Rangers.


Despite playing well the Harps A.F.L. Seniors team were beaten 2-0 in the semi-final of the Jim Byrne Cup by a strong Rivermount team. The U-18 team defeated Howth 2-0 and must await the results of other games to see if they retain top position in the league.





A MESSAGE FROM STEVEN RAFFERTY





I would like to take this opportunity to thank all those involved in the recent benefit draw held on my behalf. I would like to thank the good friends who organized it, the kindness of those who sponsored prizes and to all those who bought tickets. It has been a hard year but it has been made easier by my good friends in Ratoath. On behalf of myself, my wife Dee and my two sons Daniel and Luke we would like to say a big Thank You.














A LITTLE THOUGHT





 When things in your life seem almost too much to handle, when 24 hours in a day are not enough, remember the mayonnaise jar and the coffee. A professor stood before his philosophy class and had some items in front of him. When the class began, wordlessly, he picked up a very large and empty mayonnaise jar and proceeded to fill it with golf balls. He then asked the students if the jar was full. They agreed that it was. So the professor then picked up a box of pebbles and poured them into the jar. He shook the jar lightly. The pebbles rolled into the open areas between the golf balls. He then asked the students again if the jar was full. They agreed it was. The professor next picked up a box of sand and poured it into the jar. Of course, the sand filled up everything else. He asked once more if the jar was full. The students responded with a unanimous "yes". The professor then produced two cups of coffee from under the table and poured the entire contents into the jar, effectively filling the empty space between the sand. The students laughed. "Now," said the professor, as the laughter subsided, "I want you to recognise that this jar represents your life. The golf balls are the important things -- your family, your children, your health, your friends, and your favourite passions -- things that if everything else was lost and only they remained, your life would still be full. "The pebbles are the other things that matter like your job, your house, your car. The sand is everything else -- the small stuff". "If you put the sand into the jar first," he continued, "there is no room for the pebbles or the golf balls. The same goes for life. If you spend all your time and energy on the small stuff, you will never have room for the things that are important to you. Pay attention to the things that are critical to your happiness. Play with your children. Take time to get medical check-ups. Take your partner out to dinner. Play another 18 holes. There will always be time to clean the house, and fix the disposal. Take care of the golf balls first, the things that really matter. Set your priorities. The rest is just sand". One of the students raised her hand and inquired what the coffee represented. The professor smiled. " I'm glad you asked," he said. "It just goes to show you that no matter how full your life may seem, there's always room for a cup of coffee with a friend."



































PH. 8256396 OR 087-2444627


E-MAIL theharp68@iolfree.ie


WEBSITE: www.ratoathharps.com





LOTTO RESULTS 22-5-07





NUMBERS DRAWN


16, 18, 20, 28.





NO JACKPOT WINNER


THE €50 WINNERS WERE





Walter Kennedy c/o R.H.


Rachel Mulryan c/o R.H.


George Ennis c/o R.H.


Biddy Doyle  c/o T. Reilly 


NEXT WEEKS JACKPOT IS


 €5000


AND THE DRAW WILL TAKE PLACE TUESDAY NIGHT IN THE AULD STAND AT 10oC.





 (On duty A.Donnelly & M.Edmonds)








RATOATH HARPS


GOLF CLASSIC


FRIDAY 20TH JULY


IN 


HOLLYSTOWN


 GOLF CLUB


PLEASE NOTE CHANGE OF DATE








UNDER 1OB MATCH REPORT BY CONOR WARD


Swords Manor 3  Ratoath Harps 2 





Swords started the game well and had an early shot saved by Conor Brown. From the kick out Peter Brazil passed a lovely ball through to Jordan Smyth to slip the ball to Matthew O Neill who tested the keeper from close range. Swords pushed Ratoath hard and were rewarded a goal just before halftime. Ratoath came out in the 2nd half with guns blazing with shots saved from Ronan Hynes and Darragh Daly. From a kick out the Swords keeper scored a goal when the ball bounced  over the Ratoath keeper to put Ratoath 2 down. Ratoath played the ball well and should have scored when a ball was passed to Matthew O Neill for the keeper to push over the bar. Swords caught Ratoath on the break to score the 3rd. Ratoath upped there play and were rewarded when Megan Walsh broke from midfield to pass to Matthew O Neill to score a cracking goal from 15 yards to bring Ratoath back into the game. From the kick-off a superb tackle in midfield by Keelan McManus passed a ball to Jelico Bachin to pass to Matthew O Neill to score from close range. Ratoath pushed Swords hard in search of a well deserved equaliser with shots from Andrew Malone and Jordan Smyth to bring the game to a close.





Team: Jelico Bachin, Peter Brazil, Conor Brown, Sean Brown, Darragh Daly, Ronan Hynes, Andrew Malone, Keelan McManus, Matthew O Neill, Kevin Roche, Jordan Smyth, Megan Walsh.


Managers: Ian Caprani, Jimmy Smyth





 �





RATOATH HARPS DEFEND IN DEPTH IN THE POLIKOFF CUP FINAL LAST SATURDAY














CREDIT UNION OF RATOATH


Phone 8257055         Fax 8257173


OPENING HOURS


Monday


 6.00 p.m. to 9.00 p.m.


Tuesday


 9.15 a.m. to 12.30 p.m.


Thursday


. 9.15 a.m. to 12.30 p.m.


2.00 p.m. to 4 p.m.


Friday


 9.15 a.m. to 12.30 p.m.


6.00 p.m. to 9.00 p.m.


Saturday


 10.30 a.m. to 12.30 p.m.
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